MANAGE CONTROL
BUDGETS

Quick REFERENCE GUIDE BuD-23

BUD

Purpose

The purpose of this Quick Reference Guide (QRG) is to provide a step-by-step explanation on how to
manage control budgets in the North Carolina Financial System (NCFS).

Introduction and Overview
This QRG covers the explanation on how to manage control budgets in NCFS which enables the user

to close control budget for use, process accounting hierarchies for budgetary control, run refresh
control budgets scheduled process, and prepare control budget for use.

Close Control Budget for Use

To manage control budgets in NCFS, please follow the steps below:

1. Login to the NCFS portal with your credentials to access the system.

2. On the Home page, click the Budgetary Control tab.

Good morning, Training Super User 1!

¢ ntercompany Accounting Budgetary Contral Cash Management Fixed Assets Exper
QUICK ACTIONS APPS
Review Budgetary Control Balances
Review Budgetary Control Transactions .
Budgetary Control NC Budget to NC LTD Budget to
Actual Dashboard LTD Actual
Dashboard

Review Budget Entries

Budgetary Control Analysis Report

|
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QRG BUD 23 — Manage Control Budgets

3. Click the Budgetary Control app.

Good morning, Training Super User 1!

¢ ntercompany Accounting Budgetary Control Cash Management Fixed Assets Exper 3

QUICK ACTIONS APPS

Review Budgetary Control Balances

Review Budgetary Control Transactions
Budgetary Control NC Budget to NC LTD Budget to

Actual Dashboard LTD Actual
Dashboard

Review Budget Entries

Budgetary Control Analysis Report

|

4. From the Budgetary Control Dashboard page, click the Tasks icon.

Budgetary Control Dashboard

4 Budget Monitor

Vieww 5 af] EF [] Detach Budget Account Group 016040 * Budget Period ‘ May-23 v

* Balance ‘ Period to date ~| )

Consumption

Budget (USD) (USD)

Funds Available
Agency Budget Fund

Total Total Amount (USD) Budget (%

14

4 Failures Requiring Attention

Failed Transactions (0) Cash Budget Status Exceptions (0)

These transactions failed during reservation of funds and didn't update budgetary control balances. After you review and correct the failures, submit the transactions for
budgetary control reprocessing.

Vieww o) i@ Detach
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5. Under Budget, click Manage Control Budgets.

Budgeis
+ Manage Control Budgets

Review Budget Entries

up 016040 * Budget Period ‘ May-23 v

Consumption -
(UsD) E] Period Close

« Budget Period Statuses
Total ¢

't update budgetary control balances. After you review and co

« Enter Budgets in Spreadsheet

* Balance ‘ Period t¢ « Review Budgetary Confrol Balances

« Carry Forward Funds Available

Review Budgetary Control Transactions

= Manage Encumbrance Carry Forward Rules

= Carry Forward Purchase Order Budgetary Control Balances

6. Click the existing control budget.

In this example, we choose NC Agency to Account Advisory CB.

Manage Control Budgets [ one |
View » Format w + 7 &
r
MName Description Status From Period To Period Ledger Project Name
I MC Agency to Account Default Advisory CB I NC Agency to Accou...  Inuse FYS_ Jul-19 FYS Jul-31 NC CASH US Any or no projec. ..
MC Appropriations NC Appropriations In use Jul-18 Jun-32 NC CASH US Any or no projec..
MC Authorized NC Authornzed In use Jul-19 Jun-32 NC CASHUS Any or no projec..
NC Certified NC Certified In use Jul-19 Jun-32 NC CASHUS Any or no projec..
NC LTD Budget NC LTD Budgst In use Jul-19 Jun-32 NC CASHUS Any or no projec. .
Columns Hidden 9
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7. Click the Action drop-down choice list.

Edit Control Budget: NC Agency to Account Defaul... & Action save v [l cancel

Status  Inuse

NC Agency to Account Default

Name Currency USD - US Dollar

Advisory CB Ledger MNC CASHUS
Default Corporate
Description | NG Agency to Account Defaul Rate Type = porale Project Any or no project on the transaction
Budget Control .
Calendar MG CASHANNUAL Level  Advisory ¥ * Budget Manager | HALLESHIA JORDAN v
From Period FYS_Jul-18 Tolerance &
Percentage ’ ' Allow budget Increase adjustments
To Period FYS_Jul-31
- Tolerance
Source . Amount + Allow budget decrease adjustments
Budget Typa COnlrol budget g I
Source hori
Budget Name 'NC Authorized Allow budget decrease adjustments below funds available
Release .
Budget for Immediately Allow overrides

Consumption
Processing Type Procure to pay

8. Select Close option.

Edit Control Budget: NC Agency to Account Defaul... @ m m
Close 5 Inuse
NC Agency to Account Default "
Name Advisory CB Currency USD -US Dollar Ledger NC CASH US
Default Corporate
Description | NC Agency to Account Defaul Rate Type P Project  Any or no proje
Budget Control ; Viiew Definition in File
Calendar 'C CASHANNUAL Level | Advisory v * Budget Manager | HALLESHIA JC
From Period FYS Jul-19 Tolerance o
. Percentage " " Allow budget increase adjustments
To Period FYS_Jul-31
s Tolerance
ource Amount v Allow budget decrease adjustments
Budget Type Control budget o I
Source .
Budget NC Authorized Allow budget decrease adjustments below funds available
Mame
Release Allow overrides
Budget for Immediately .
Consumption Processing Type [Procure to pay
4 Control Budget Structure
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9. The Warning pop-up will appear, click the Yes button.

/A Warning x

If you close this budget, transactions controlled by this budget will fail budgetary control while it's closed. Do you want to continue?

Process Accounting Hierarchies for Budgetary Control

1. Navigate to Home page and then click the Tools tab.

Good morning, Training Super User 1!

& =Xpenses Procurement My Enterprise Tools Configuration Others

QUICK ACTIONS APPS

Manage Collaboration Messaging

History p—
=2
Al Apps Administration
Set Preferences Alerts Composer Developer
Connect
almmta
B
Worklist Reports and Scheduled
Analytics Processes
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2. Click the Scheduled Processes app.

Good morning, Training Super User 1!

& =Xpenses Procurement My Enterprise Tools Configuration

QUICK ACTIONS APPS

Manage Collaboration Messaging
History

Al Apps Administration

Set Preferences Alerts Composer

Others

Worklist Reports and Scheduled
Analytics Pracesses
3. Click the Schedule New Process button.
Overview @
b Search Saved Search | Last hour &
Search Results (?)
View (@) Flat List Hierarchy
Actions w View v Schedule New Process 29}

Name Process ID Status Scheduled Time Submission Time
Ingesting attachments to OSCS 2179425 Wait 5/18/23 11:32AMEDT  5/18/23 11:22 AMEDT
ESS process to check Search Cloud Service availability 2179424 Wait 5/18/23 11:27 AMEDT ~ 5/18/23 11:22 AM EDT
Provide Online Transaction Engine Functionality 2179423 Running 5/18/23 11:22 AM EDT  5/18/23 11:22 AM EDT
Provide Online Transaction Engine Functionality 2179422 Running 5/18/23 11:21 AMEDT  5/18/23 11:21 AMEDT
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4. Click the Arrow [B] icon.

Schedule New Process

Type (®) Job () Job Set

ame |

Description

5. Click the Search link.

Evaluate Absences: Subprocess
Process Events

Schedule Ne¢ Process Events: Subprocess

Migrate Previous Versions of Absence Data
TYPe | Dependent Job

Advanced Controls Notifications
Name

Update Accrual Plan Enroliments

Description

Update Accrual Plan Enrollments: Subprocess

Calculate Accruals and Balances

Calculate Accrual and Balances: Subpracess

4
Search...
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6. Inthe Name field, Enter process account hierarchies.

Search and Select: Name

4 Search

Name | process account hierarchies

Search || Reset

Name

Process Account Hierarchies

.|

7. Click the Search button.

Search and Select: Name

4 Search

Name | process account hierarchies

Name

Process Account Hierarchies

« |
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8. Select the Process Account Hierarchies from the result section.

Search and Select: Name

4 Search

Name | process account hierarchies

Name

| Process Account Hierarchies

«

9. Click the OK button.

Search and Select: Name

4 Search

Name | process account hierarchies

Name

Process Account Hierarchies

.|
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10. The Process Account Hierarchies is updated in the Name field, Click the OK button.

Schedule New Process

Type (@) Job () Job Set

Name | Process Account Hierarchies

Description Submits account hierarchies related processes including row flattening, column flattening, tree audit, tree activation,
maintain value sets process, maintain account hierarchies process, and publish hierarchies process.

Cancel

11. Enter the required parameters.

Process Details x
@ This process will be queued up for submission at position 1
Process Options Advanced Submit Cancel
Name Process Account Hierarchies
Description Submits account hierarchies related processes i... D Notify me when this process ends
Schedule As soon as possible Submission Notes ’
Basic Options
Parameters
* Value Set l Account NC CASH Account NC CASH v ‘
Tree Name l Account NC CASH Account NC CASH v ‘
Tree Version Name | Account NC CASH Current Account NC CASH Current v
Publish Hierarchies
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12. Click the Submit button.

Process Details x
O This process will be queued up for submission at position 1
‘ Process Options ‘ ‘ Advanced ‘ ‘ Submit ‘ ‘ Cancel ‘
Name Process Account Hierarchies
Description Submits account hierarchies related processes i... D Notify me when this process ends
Schedule As soon as possible Submission Notes {

Basic Options
Parameters

* Value Set l Account NC CASH Account NC CASH VI

Tree Name l Account NC CASH Account NC CASH VI

Tree Version Name | Account NC CASH Current Account NC CASH Current VI

Publish Hierarchies

13. The Confirmation pop-up appears, Click the OK button.

[ Confirmation

Process 2179437 was submitted.
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Run Refresh Control Budgets scheduled process

1. Navigate to Home page and then click the Tools tab.

Good morning, Training Super User 1!

< =xpense Procurement

w

QUICK ACTIONS

Manage Collaboration Messaging
History

Al Apps Administration

My Enterprise

Tools

Configuration Others

APPS

Set Preferences

Worklist

Alerts Composer

Scheduled

Processes

Reports and
Analytics

2. Click the Scheduled Processes app.

Good morning, Training Super User 1!

< zXpenses Procurement

QUICK ACTIONS

Manage Collaboration Messaging
History

Al Apps Administration

My Enterprise

APPS

Set Preferences

Waorklist

Tools

Configuration Others

Alerts Composer

Developer
Connect

Scheduled

Processes

Reports and
Analytics
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3. Click the Schedule New Process button.

Overview @

b Search Saved Search

Search Results (2)

View (@) FlatList () Hierarchy
Actions w View w Resubmit PutOnHold Cancel Process Release Process  ViewLog 4)

Name Process ID Status Scheduled Time Submission Time
Ingesting attachments to OSCS 2179425 Wait 5/118/23 11:32AMEDT  5/18/23 11:22 AMEDT
ESS process to check Search Cloud Service availability 2179424 Wait 5/18/23 11:27 AMEDT  5/18/23 11:22 AM EDT
Provide Online Transaction Engine Functionality 2179423 Running 5/18/23 11:22 AMEDT  5/18/23 11:22 AM EDT
Provide Online Transaction Engine Functionality 2179422 Running 5/18/23 11:21 AMEDT  5/18/23 11:21 AMEDT

-
T

4. Click the Arrow [E] icon.

Schedule New Process

Type (@) Job () Job Set

Name

Description
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5. Click the Search link.

Evaluate Absences: Subprocess
Process Events

Schedule N¢ Process Events: Subprocess
Migrate Previous Versions of Absence Data

TYPe | Dependent Job

Advanced Controls Notifications
Name

Update Accrual Plan Enroliments

Description | \j5qate Accrual Plan Enrollments: Subprocess
Calculate Accruals and Balances

Calculate Accrual and Balances: Subpracess

4
Search...

6. Inthe Name field, Enter Refresh Tree for Budgetary Control.

Search and Select: Name

4 Search

Name | Refresh Tree for Budgetary Control
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7. Click the Search button.

Search and Select: Name

4 Search

Name | Refresh Tree for Budgetary Control

8. Select the Refresh Tree for Budgetary Control from the result.

Search and Select: Name x

4 Search ‘ Basic ‘

Name | Refresh Tree for Budgetary Centrol ‘

e

Name

| Refresh Tree for Budgetary Control ! %
1 »

\i! . Cancel ‘
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9. Click the OK button.

Search and Select: Name

4 Search

Name Refresh Tree for Budgetary Control

Refrash Tree for Budgetary Control
.|

10. The Refresh Tree for Budgetary Control is updated in the Name field, Click the OK button.

Schedule New Process

Type (@) Job () Job Set .
Refresh Tree for Budgetary
Control

Name I Refresh Tree for Budgetary Control

Description Refreshes the copy of a tree maintained in Budgetary Control after the tree is revised and row flattened.
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11. Enter the parameters.

Process Details x

@ This process will be queued up for submission at position 1

‘ Process Options . ‘ Advanced ‘ ‘ Submit‘ . Cancel ‘

Refresh Tree for Budgetary
Name Control
Description Refreshes the copy of a tree maintained in Budg... j Notify me when this process ends
Schedule As soon as possible Submission Notes

Basic Options

Parameters

* Tree | Account NC CASH - Account NC CASH| w

Account NC CASH - Account NC CASH ...

Account NC CASH - Account NC CASH ...

Search...

12. Click the Submit button.

Process Details x
@ This process will be queued up for submission at posilion 1

‘Process Dptinns| Advanced Submit Cancel

Refresh Tree for Budgetary
Name ¢ ontrol
Description Refreshes the copy of a tree maintained in Budg... j Notify me when this process ends
Schedule As soon as possible Submission Notes

Basic Options

Parameters

* Tree | Account NC CASH - Account NC CASH| w
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13. The Confirmation pop-up appears, Click the OK button.

[§&} Confirmation

Process 2204137 was submitted.

Prepare Control Budget for Use

1. Navigate to Home page and then click the Budgetary Control tab.

Good morning, Training Super User 1!

¢ ntercompany Accounting Budgetary Control Cash Management Fixed Assets Expel

QUICK ACTIONS APPS

Review Budgetary Control Balances

@ o

Review Budgetary Control Transactions

Budgetary Control NC Budget to NC LTD Budget to
Actual Dashboard LTD Actual
Dashboard

Review Budget Entries

Budgetary Control Analysis Report

i
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2. Click the Budgetary Control app.

Good morning, Training Super User 1!

¢ ntercompany Accounting Budgetary Control Cash Management Fixed Assets Exper 3

QUICK ACTIONS APPS

Review Budgetary Control Balances

Review Budgetary Control Transactions
Budgetary Control NC Budget to NC LTD Budget to

Actual Dashboard LTD Actual
Dashboard

Review Budget Entries

Budgetary Control Analysis Report

|

3. From the Budgetary Control Dashboard page, click the Tasks icon.

Budgetary Control Dashboard

4 Budget Monitor

Vieww 5 af] EF [] Detach Budget Account Group 016040 * Budget Period ‘ May-23 v

* Balance ‘ Period to date ~| )

Consumption

Budget (USD) (USD)

Funds Available
Agency Budget Fund

Total Total Amount (USD) Budget (%

14

4 Failures Requiring Attention

Failed Transactions (0) Cash Budget Status Exceptions (0)

These transactions failed during reservation of funds and didn't update budgetary control balances. After you review and correct the failures, submit the transactions for
budgetary control reprocessing.

Vieww o) i@ Detach
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4. Under Budget, click Manage Control Budgets.

Budgeis
+ Manage Control Budgets

« Enter Budgets in Spreadsheet

Review Budget Entries

up 016040 * Budget Period ‘ May-23 v | * Balance ‘ Period ¢ = Review Budgetary Control Balances

Review Budgetary Control Transactions
Consumption -

(UsD) E] Period Close

« Budget Period Statuses

Total
= Manage Encumbrance Carry Forward Rules
« Carry Forward Funds Available

= Carry Forward Purchase Order Budgetary Control Balances

't update budgetary control balances. After you review and co

5. From the Manage Control Budgets page, select NC Agency to Account Default Advisory CB
control budget with status Closed.

Manage Control Budgets
View w Format w o E
&
e From 2 F
Name Description Status Period To Period Ledger Project Name
NC Appropriations NC Appropriations In use Jul-19 Jun-32 NC CASH US Any or no project on the transaction
NC Authorized NC Authorized In use Jul-19 Jun-32 NC CASH US  Any or no project on the transaction
NC Certified NC Certified In use Jul-19 Jun-32 NC CASHUS  Any or no project on the transaction
NC LTD Budget NC LTD Budget Inuse Jul-18 Jun-32 NC CASHUS  Any or no project on the transaction
I NC Agency to Account Default Advisory CB I NC Agency to Account Default Advisory CB Closed FYS_Jul-18 FYS_Jul-31 NC CASHUS  Any or no project on the transaction
Columns Hidden 9
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6. Click the Action arrow and select Prepare for Use.

Edit Control Budget: NC Agency to Account Defaul... @
Prepare for Use
Cloto Closed
NC Agency to Account Default P tly Cl
Name Advisory CB Currency USD - US Dollar Ledger NC CASH US ermanenily Ulose
Default
Description | NC Agency to Account Defaul Rate Type Corporate Project Any or no proje Redefine
Budget Control | i View Definition in File
Calendar NG CASHANNUAL Level | Advisory v * Budget Manager rHALLESHIAJC —
From Period FYS_Jul-19 Tolerance | o
Percentage : + Allow budget increase adjustments
To Period FYS_Jul-31
s Tolerance
ource Amount Allow budget d djustment
Budget Type Control budget +| Allow budget decrease adjustments
Source )
Budget NC Authorized | Allow budget decrease adjustments below funds available
Name
Release — Allow overrides
Budget for Immediately .
Consumption Processing Type Procure to pay

7. The Warning pop-up appears, click the Yes button.

[\ Warning x

If you prepare this control budget for use, transactions will be subject to the control of this budget. Do you want to continue?

Yes No

8. The status of the Control Budget is updated to In-Use.

Manage Control Budgets

View w Formalw o

rd
Name Description Status From Period To Period Ledger Project Name
I NC Agency fo Account Default Advisory CB I NC Agency to Accou.. . FYS_Jul-19 FYS_Jul-31 MNC CASHUS Any or no projec...
NC Approprations NC Appropriations Inuse Jul-19 Jun-32 MNC CASH US Any or no projec. ..
MNC Authorized NC Authorized In use Jul-18 Jun-32 NC CASH US Any or no projec...
NC Certified NC Certified Inuse Jul-19 Jun-32 NC CASHUS Any OF NG PIojec. ..
NC LTD Budget NC LTD Budget Inuse Jul-19 Jun-32 MNC CASH US Any or no projec...

Columns Hidden 9
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Wrap-Up

Manage Control Budgets using the steps above in NCFS to close control budget for use, process

accounting hierarchies for budgetary control, run refresh control budgets scheduled process, and
prepare control budget for use.
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